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BAB II  

LANDASAN TEORI 

 

2.1  Tinjauan Pustaka 

Dalam melakukan penelitian lebih lanjut perlu dilakukan identifikasi dan 

pendalaman teori-teori berdasarkan penelitian-penelitian terdahulu yang relevan, 

guna membantu dan mengarahkan fokus pada penelitian ini. Penelitian mengenai 

sistem deteksi sambaran petir telah banyak dilakukan dengan pendekatan dan 

metode yang beragam, mulai dari penggunaan sensor komersial hingga rangkaian 

elektronik sederhana berbasis prinsip modulasi amplitudo (AM). 

1) Penelitian oleh Mialdea-Flor et al. (2022) mengusulkan pengembangan sistem 

deteksi sambaran petir berbasis Internet of Things (IoT) dengan pendekatan 

desentralisasi. Sistem yang dirancang menggunakan kombinasi sensor 

elektromagnetik sederhana yang terhubung ke mikrokontroler NodeMCU 

ESP8266, serta modul GPS dan koneksi Wi-Fi untuk mengirim data ke server 

terpusat. Deteksi petir dilakukan berdasarkan fluktuasi tegangan yang 

signifikan akibat gelombang elektromagnetik dari sambaran petir. Hasil 

penelitian menunjukkan bahwa sistem berhasil mencatat waktu dan lokasi 

kejadian petir secara akurat dan dapat diakses melalui antarmuka berbasis web. 

Sistem ini relatif murah dan bersifat portabel, namun akurasi perancangan 

sistem dapat dikatakan kompleks dan rumit deteksinya sangat bergantung pada 

pengolahan sinyal digital [4]. 

2) Berdasarkan penelitian yang dilakukan oleh Carvalho Jr. et al. (2023) 

mengembangkan sistem pendeteksi sambaran petir otonom menggunakan 

split-core Rogowski coil yang dikombinasikan dengan rangkaian integrator 

aktif dan modul pemrosesan berbasis mikrokontroler. Sensor Rogowski 

dipasang secara non invasif di sekitar konduktor menara transmisi; hasil 

tegangan yang dihasilkan, proporsional dengan laju perubahan arus petir, 

diolah oleh rangkaian integrator aktif sehingga menghasilkan sinyal keluaran 

yang sebanding dengan arus sambaran asli. Sistem ini dilengkapi modul 

impulse detector yang menggunakan beberapa ambang batas amplitude 
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(threshold) untuk mengklasifikasi intensitas sambaran (misalnya >600 A, 5 kA, 

10 kA) dan mencatat kejadian ke dalam unit pemrosesan mikrocontroller serta 

microSD. Pengujian awal di laboratorium menunjukkan deteksi yang cepat dan 

akurat, sedangkan pengujian lapangan awal pada menara 345 kV menegaskan 

reliabilitas sistem dalam operasi jangka panjang. Keunggulan utama sistem ini 

adalah kemampuannya mendeteksi sambaran petir dalam kisaran arus besar 

(500 A–100 kA) dengan toleransi kesalahan di bawah 10%. Namun, sistem ini 

tidak memiliki konektivitas IoT secara langsung dan dirancang untuk instalasi 

tetap, bukan sistem portabel atau berbasis sinyal analog AM [5]. 

3) Berdasarkan penelitian yang dilakukan oleh Petrick Mikhael Sidauruk, Sonny 

Sumaryo, Ekki Kurniawan pada e-Proceeding of Engineering dengan judul 

“Sistem Pendeteksi Dini Petir” dijelaskan bahwa Jurnal ini membahas 

pengembangan sistem pendeteksi dini petir menggunakan sensor Franklin 

AS3935 yang terhubung dengan mikrokontroler ESP32 dan Arduino IDE. 

Sistem ini dirancang untuk mendeteksi keberadaan petir dan memberikan 

peringatan dini untuk melindungi manusia dan perangkat elektronik. Hasil 

penelitian menunjukkan bahwa alat ini dapat mendeteksi petir pada jarak 1 km, 

5 km, dan 10 km. Kelebihan dari sistem ini termasuk kemampuannya untuk 

memberikan peringatan sebelum sambaran petir benar-benar terjadi, serta 

penggunaan teknologi yang terjangkau dan efisien. Namun, terdapat beberapa 

kekurangan, seperti keterbatasan dalam mendeteksi petir pada jarak yang lebih 

jauh dan ketidakmampuan sistem untuk menyimpan riwayat deteksi dalam 

aplikasi Android, yang dapat mengurangi efektivitas pemantauan [6]. 

4) Berdasarkan penelitian yang dilakukan oeh Nia Anggraini pada Skripsi dengan 

judul “Sistem Monitoring Alat Proteksi Petir Berbasis WEB Menggunakan 

ESP8266” dijelaskan bahwa Jurnal ini membahas pengembangan sistem 

monitoring untuk alat proteksi petir yang menggunakan teknologi web berbasis 

ESP8266. Sistem ini dirancang untuk memantau sambaran petir secara real-

time, mencatat informasi penting seperti waktu, tanggal, dan besarnya arus 

sambaran petir. Hasil penelitian menunjukkan bahwa alat monitoring ini 

berhasil mengidentifikasi dan merekam setiap sambaran petir dengan tingkat 
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akurasi yang baik, dengan rata-rata error sebesar 4.8% yang dipengaruhi oleh 

ketelitian sensor yang digunakan. Kelebihan dari sistem ini adalah 

kemampuannya untuk menyediakan data secara langsung melalui jaringan, 

sehingga memudahkan pemantauan dan perawatan sistem proteksi petir tanpa 

harus hadir secara fisik di lokasi. Namun, terdapat beberapa kekurangan, biaya 

implementasi yang tinggi. Secara keseluruhan, penelitian ini memberikan 

kontribusi signifikan dalam meningkatkan efektivitas sistem proteksi petir di 

Indonesia, yang memiliki frekuensi sambaran petir yang tinggi [7]. 

Berdasarkan hasil kajian pustaka terhadap penelitian yang telah dilakukan 

tersebut, dapat disimpulkan bahwa penerapan sistem pendeteksi dan monitoring 

sambaran petir berbasis mikrokontroler dan jaringan internet memiliki prospek 

yang menjanjikan dalam upaya mitigasi risiko di wilayah rawan petir. Namun masih 

terdapat keterbatasan. Diantaranya pada proses integrasi alat dan IoT. Keterbatasan 

pada fitur pendukung pada pembacaan potensi gelombang elektromagnetik petir, 

seperti suhu dan tekanan udara, Keterbatasan pada konsistensi pembacaan pada 

sensor. Secara keseluruhan, seluruh penelitian tersebut menunjukkan arah 

perkembangan sistem pendeteksi petir yang progresif, namun optimalisasi sistem 

seperti penambahan sensor skematik elektronika dapat dilakukan sebagai 

pembanding dan peningkatan integrasi perangkat, redundansi konektivitas, dan 

monitoring melalui website solusi terhadap keterbatasan yang ada. 

 

2.2  Dasar Teori 

2.2.1 Petir 

  Petir merupakan fenomena alam dimana terbentuk dari awan memiliki 

kandungan listrik yang tersusun pada atmosfer dengan membentuk gumpalan 

gumpalan hingga terjadinya proses pelepasan muatan elektrostatis yang berasal dari 

badai guntur yang cukup tinggi. Pada proses pembuangan muatan ini, media yang 

dilalui elektron adalah udara. Pada saat elektron mampu menembus ambang batas 

isolasi udara inilah terjadi ledakan suara. Fenomena alam tersebut biasanya muncul 

di langit berupa kilatan cahaya yang kemudian disertai dengan suara menggelegar 

yang dijumpai ketika atau menjelang hujan [8]. 



9 

 

 

 

 

Gambar 2. 1 Proses terjadinya petir 

 

  Setiap proses terjadiya petir ini memiliki medan listrik dan magnet yang 

menyertainya. Petir diketahui memancarkan energi elektromagnetik yang 

signifikan dalam rentang frekuensi dari di bawah 1 Hz hingga mendekati 300 MHz, 

dengan puncak spektrum frekuensi mendekati 5–10 kHz untuk petir pada jarak 

lebih dari 50 km atau lebih. Lebih lanjut, radiasi elektromagnetik dari petir dapat 

dideteksi pada frekuensi yang lebih tinggi 300 MHz hingga 300 GHz [9]. 

  Menurut Le Vine (1986) [10], dalam Review of Measurements of the RF 

Spectrum of Radiation from Lightning salah satu hasil pengukuran medan listrik 

petir dijelaskan melalui gelombang E(t) (electric field waveform). Dalam 

dokumentasi menunjukkan bahwa gelombang medan listrik petir E(t) memiliki 

bentuk khas berupa kenaikan amplitudo yang sangat cepat menuju puncak (rapid 

rise to peak), kemudian diikuti dengan penurunan tidak beraturan menuju nol. 

Sebelum lonjakan utama (return stroke), seringkali muncul deretan pulsa kecil yang 

dikenal sebagai stepped leader. Ketika gelombang ini dianalisis dengan 

transformasi Fourier, hasilnya memperlihatkan spektrum frekuensi yang lebar, 

dengan energi dominan pada pita frekuensi rendah hingga menengah (kHz–MHz). 
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Hasil pengamatan gelombang dari Thunderstorm Research International Project 

(TRIP) pada 20 July 1976 ini dapat dilihat pada gambar 2.2 dan 2.3.  

 

 

Gambar 2. 2 Bentuk Amplitudo medan listrik dari penelitian Florida selama 

TRIP-76 

 

  Gelombang dimulai tiba-tiba (abrupt) dengan kenaikan sangat cepat menuju 

puncak, direntang waktu dibawah dari 10uS. Setelah puncak, sinyal menurun secara 

tidak teratur (decay irregular) hingga kembali mendekati nol atau stabil. Pada 

banyak kasus, sebelum lonjakan besar (return stroke) muncul rangkaian pulsa kecil 

yang disebut stepped leader. Pulsa ini adalah proses bertahap turunnya muatan 

listrik dari awan menuju tanah sebelum akhirnya terjadi sambaran utama. Ketika 

gelombang ini dianalisis dengan transformasi Fourier, hasilnya memperlihatkan 

spektrum frekuensi yang lebar, dengan energi dominan pada pita frekuensi rendah 

hingga menengah (kHz–MHz) yang hasilnya dapat dilihat pada gambar 2.3.  
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Gambar 2. 3 Frekuensi gelombang dari penelitian Florida selama TRIP-76 

 

  Petir dibedakan menjadi 4 macam, antara lain :  

1. Petir awan ke tanah / Cloud to Ground (CG) adalah petir yang paling 

berbahaya dan merusak. Petir ini berasal dari pusat muatan yang lebih rendah 

dan mengalirkan muatan negatif ke tanah. 

2. Petir dalam awan / Intercloud (IC) adalah petir yang paling umum terjadi 

diantara pusat- pusat muatan yang berlawanan pada awan yang sama.  

3. Petir awan ke awan / Cloud to Cloud (CC) adalah petir yang terjadi diantara 

pusatpusat muatan pada awan yang berbeda. Pelepasan muatan terjadi ketika 

udara cerah pada awan- awan tersebut.  

4. Petir awan ke udara / Cloud to Air (CA) adalah petir yang terjadi jika udara 

disekitar awan bermuatan positif berinteraksi dengan awan bermuatan negatif. 

Berdasarkan muatannya petir dibedakan menjadi 2 macam yaitu yaitu petir 

negatif (-) dan petir positif(+). 
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Gambar 2. 4 Peta kepadatan sambaran petir Indonesia april 2025 

    

  Selama Bulan April 2025, Total Sambaran Petir CG sangat bervariasi. Jumlah 

total sambaran CG pada bulan April 2025 sedikit menurun apabila dibandingkan 

dengan bulan Maret 2025. Wilayah yang memiliki jumlah sambaran total CG > 

60.000 terjadi di sebagian wilayah Indonesia [11]. 

  Selain itu beberapa studi menunjukkan bahwa parameter meteorologi 

permukaan seperti suhu udara, kelembaban relatif, dan tekanan udara memiliki 

korelasi signifikan dengan aktivitas sambaran petir. Pada salah satu studi 

menyimpulkan bahwa peningkatan suhu udara berkorelasi dengan peningkatan 

densitas sambaran petir sebesar 20–44% ketika suhu permukaan berkisar antara 30–

35°C, khususnya di wilayah tropis [12]. Sementara itu, hasil studi di daerah pesisir 

menunjukkan bahwa kelembaban yang relatif tinggi diatas 70% dapat 

meningkatkan probabilitas terjadinya sambaran petir, terutama melalui 

pembentukan partikel awan dan uap air yang memicu pelepasan muatan listrik. 

Adapun tekanan udara mempengaruhi stabilitas atmosfer secara keseluruhan. 

Penurunan tekanan udara umumnya dibawah 900 hPa menjadi tanda adanya 

ketidakstabilan atmosfer dan mendekatnya sistem cuaca buruk, termasuk badai 

petir 
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  Ketiga parameter dapat saling mendukung dalam membentuk kondisi 

atmosfer yang mendukung terjadinya petir. Kombinasi suhu tinggi, kelembaban 

relatif tinggi, dan tekanan udara rendah memperbesar kemungkinan terbentuknya 

awan badai cumulonimbus yang berpotensi besar menghasilkan petir. 

   

2.2.2 Amplitude Modulation  

  Modulasi amplitudo atau Amplitude Modulation (AM) adalah teknik 

modulasi dalam komunikasi analog. Gelombang pembawa AM memiliki rentang 

frekuensi 535 kHz hingga 1605 kHz dalam sistem siaran radio. Pada sistem 

elektronik, gelombang AM pada umumnya dimanfaatkan untuk transmisi audio, 

namun dapat juga mendeteksi perubahan energi elektromagnetik [13].  

  Prinsip dasar deteksi ini adalah impuls petir menyebabkan gangguan 

amplitudo pada gelombang pembawa. Gelombang elektromagnetik dari petir 

memiliki sifat sangat tajam (spike) sehingga mampu menimbulkan fluktuasi 

amplitudo secara tiba-tiba.  

  Dalam konteks sistem deteksi petir, prinsip AM tidak digunakan untuk 

mentransmisikan suara, melainkan untuk menangkap perubahan amplitudo akibat 

impuls elektromagnetik. Ketika gelombang elektromagnetik dari petir tertangkap 

oleh antena, perubahan amplitudo yang tajam akan terdeteksi dan diproses oleh 

TA7642 menjadi sinyal analog atau yang kemudian dikirim dan diproses oleh 

mikrokontroler. 

  Dengan demikian, penerima AM akan sensitif terhadap perubahan 

amplitudo akibat radiasi petir. Prinsip dasar inilah yang memungkinkan sistem 

untuk mengidentifikasi adanya sambaran petir, yaitu dengan membaca anomali 

amplitudo sinyal yang tidak berasal dari sumber komunikasi radio, melainkan dari 

impuls elektromagnetik alami. 

 

2.2.3 Integrated Circuit 

  IC atau integrated circuit merupakan suatu komponen elektronik yang terdiri 

atas kumpulan elemen aktif seperti transistor dan dioda serta elemen pasif seperti 

resistor dan kapasitor yang diintegrasikan menjadi satu. Chip ini terbuat dari bahan 
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semikonduktor silikon dan dikemas dalam bentuk kecil namun memiliki fungsi 

yang sangat kompleks. Selain itu IC dapat menjalankan berbagai tugas seperti 

penguatan sinyal, pengolahan data, konversi sinyal, pengendalian logika, hingga 

komunikasi. 

  Secara umum, IC dapat dibagi menjadi dua kategori besar, yaitu IC digital 

dan IC analog. Sementara itu, IC analog berfungsi dalam pengolahan sinyal 

kontinyu, seperti penguat suara, sensor, dan sistem komunikasi. IC TA7642 

digunakan sebagai detektor gelombang radio AM pada frekuensi rendah di kisaran 

150 kHz hingga 3 MHz. IC ini bekerja dengan mendeteksi sinyal AM yang diterima 

oleh antena, lalu memperkuat dan mendemodulasi sinyal tersebut menjadi sinyal 

listrik berfrekuensi rendah, dalam frekuensi menengah (Medium Wave, MW). IC 

mampu bekerja dengan konsumsi daya yang sangat rendah dan hanya 

membutuhkan sedikit komponen eksternal [14].  

  Pada sistem deteksi sambaran petir berbasis IC TA7642, antena yang 

digunakan berfungsi untuk menangkap gangguan elektromagnetik yang dihasilkan 

oleh petir. Petir merupakan fenomena alam yang menghasilkan gelombang 

elektromagnetik dengan frekuensi yang luas. Dalam konteks ini, gangguan 

elektromagnetik akibat sambaran petir dimanfaatkan sebagai indikasi keberadaan 

petir di sekitar. 

  Namun demikian, IC TA7642 secara prinsip kerja dirancang untuk 

mendeteksi sinyal AM yang memiliki komponen sinyal pembawa carrier signal. 

Oleh karena itu, untuk mengaktifkan fungsi deteksi dari IC TA7642, sistem perlu 

diberikan sinyal pembawa buatan. Dalam penelitian ini, sinyal pembawa digantikan 

oleh pulsa PWM (Pulse Width Modulation) yang berasal dari mikrokontroler. 

Sinyal PWM tersebut diatur sedemikian rupa dengan duty cycle dan frekuensi 

tertentu agar menyerupai sinyal AM setelah melalui proses penyaringan filter RC 

sehingga menghasilkan gelombang analog yang halus. 
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Gambar 2. 5 Integrated Circuit 

 

2.2.4 Rangakaian Penerima Sinyal AM  

  Rangkaian penerima sinyal Amplitude Modulation (AM) secara umum 

digunakan dalam sistem komunikasi radio untuk menangkap gelombang pembawa 

yang dimodulasi oleh sinyal informasi. Prinsip dasarnya terdiri atas tiga bagian 

utama, yaitu antena sebagai penangkap gelombang elektromagnetik, rangkaian 

penyaring filter atau resonansi LC untuk memilih pita frekuensi tertentu, serta 

detektor AM yang berfungsi mendemodulasi sinyal menjadi bentuk audio atau 

sinyal informasi yang dapat dimanfaatkan lebih lanjut. 

  Cara kerja penerima AM pada radio adalah menerima sinyal pembawa 

(carrier) yang sudah dimodulasi amplitudo oleh informasi suara. Gelombang 

pembawa ini kemudian difilter agar sesuai dengan frekuensi kanal radio tertentu. 

Proses demodulasi dilakukan dengan mendeteksi perubahan amplitudo sinyal 

carrier, sehingga dapat diperoleh kembali sinyal audio asli. Oleh karena itu, 

penerima radio AM membutuhkan gelombang pembawa yang stabil dari stasiun 

pemancar radio, serta rangkaian penguat audio untuk menghasilkan suara. 

  Pada perancangan alat ini mengadaptasi rangkaian penerima sinyal Amplitude 

Modulation. Rangkaian ini dirancang untuk mendeteksi medan listrik dari 

gelombang elektromagnetik yang dihasilkan oleh sambaran petir melalui sistem 

penerima berbasis antena dan IC detektor AM TA7642 dengan skematik rangkaian 

seperti pada gambar 2.6.  
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Gambar 2. 6 Rangkaian Sinyal AM 

   

  Prinsip kerja rangkaian dimulai dari antena teleskopik, yang berfungsi 

menangkap gangguan elektromagnetik (Electromagnetic Interference, EMI) akibat 

sambaran petir. Sinyal dari antena pada dasarnya sangat lemah dan masih 

bercampur dengan noise, sehingga perlu melalui tahap penyaringan frekuensi. 

  Tahap penyaringan dilakukan dengan rangkaian LC resonansi yang terdiri 

atas induktor (L) dan kapasitor (C). Rangkaian ini berfungsi sebagai band-pass 

filter yang hanya meloloskan sinyal pada frekuensi tertentu. Frekuensi resonansi 

ditentukan dengan persamaan: 

f0 = 
1

2𝜋√𝐿𝐶
= (2.1) 

 

  Setelah melalui tahap resonansi, sinyal diteruskan ke IC TA7642 sebagai 

detektor AM. IC TA7642 ini berfungsi memperkuat dan mendemodulasi perubahan 

amplitudo dari sinyal yang masuk. Namun, karena TA7642 pada prinsipnya 

membutuhkan sinyal pembawa (carrier), sistem memberikan sinyal pembawa 

buatan dalam bentuk PWM (Pulse Width Modulation) yang dihasilkan 

mikrokontroler ESP8266. Untuk menentukan nilai PWM yang sesuai dengan 

spesifikasi dari IC TA7642 perlu terlebih dahulu menghitung dengan perhitungan 

sebagai berikut: 

Vavg  = 
𝑃𝑊𝑀

𝐴𝐷𝐶 𝑀𝑎𝑘𝑠
× 𝑉𝑐𝑐 = (2.2) 
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  Diketahui pada perancangan alat ini menggunakan mikrokontroler ESP8266 

memiliki rentang nilai ADC dari 0 hingga 1023 dimana nilai tersebut dapat 

berfungsi mengatur nilai tegangannya, maka perhitungan nilai PWM sangat penting 

dan berpengaruh kepada titik kerja rangkaian, setelah melewati rangkaian low-pass 

RC terbentuk tegangan rata-rata yang stabil. Tegangan ini berfungsi sebagai sinyal 

referensi atau carrier buatan bagi IC TA7642. Dengan demikian, ketika terjadi 

gangguan impulsif akibat sambaran petir, amplitudo dari sinyal referensi tersebut 

akan berfluktuasi, dan IC TA7642 akan merespons perubahan tersebut dengan 

menghasilkan sinyal analog pada keluarannya. 

  Agar sistem bisa membedakan sinyal petir dan noise, digunakan pendekatan 

delta perubahan sinyal digunakan metode delta filtering, yaitu dengan menghitung 

selisih nilai pembacaan ADC saat ini dan sebelumnya yaitu: 

Δ = |ActValue − PrevValue| (2.3) 

 

  Penentuan threshold penting untuk meredam noise. Noise dari lingkungan 

biasanya hanya menghasilkan perubahan kecil pada sinyal, sedangkan sambaran 

petir menghasilkan lonjakan besar dan tajam. Dengan menetapkan threshold, sistem 

hanya merespons sinyal dengan lonjakan Amplitudo yang signifikan atau Jika Δ 

melebihi nilai ambang (threshold), misalnya Δ ≥ 5, maka peristiwa tersebut 

dikategorikan sebagai deteksi sambaran petir. berfungsi untuk membedakan antara 

sinyal petir dengan noise lingkungan 

  Dengan demikian, rangkaian penerima sinyal AM dalam penelitian ini tidak 

berfungsi sebagai penerima radio AM murni, tetapi sebagai sistem deteksi impuls 

elektromagnetik petir. Kombinasi antara antena teleskopik, filter resonansi LC, IC 

TA7642, sinyal PWM sebagai carrier buatan, serta metode delta filtering pada ADC 

menjadikan sistem ini mampu mengonversi fenomena elektromagnetik sambaran 

petir menjadi data digital yang dapat diproses lebih lanjut oleh mikrokontroler 
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2.2.5 Mikrokontroler 

Mikrokontroler merupakan suatu sistem komputer miniatur yang terdapat 

dalam sebuah chip tunggal, yang mengintegrasikan unit pemrosesan data (CPU), 

memori (RAM dan ROM), serta perangkat input/output (I/O) dalam satu kesatuan. 

Mikrokontroler dirancang untuk melakukan tugas-tugas pengendalian secara 

otomatis terhadap perangkat elektronik atau sistem mekanik. Pada prinsipnya, 

mikrokontroler berfungsi sebagai otak dari suatu sistem tertanam (embedded 

system) yang bertugas membaca data dari sensor, memproses data tersebut 

berdasarkan algoritma tertentu, dan memberikan perintah atau respons melalui 

aktuator atau media komunikasi lainnya. 

 

2.2.5.1 ESP8266 

Mikrokontroler ESP8266 merupakan sebuah modul Wi-Fi System-on-Chip 

(SoC) yang dikembangkan oleh perusahaan Espressif Systems. Mikrokontroler ini 

dirancang untuk mendukung aplikasi Internet of Things (IoT) dengan menyediakan 

konektivitas WiFi dan Bluetooth dalam satu modul. SoC System-on-Chip yang 

dikembangkan oleh Espressif Systems, mengintegrasikan prosesor 32-bit berbasis 

Tensilica L106 dengan konektivitas IEEE 802.11 b/g/n. 

Module NodeMCU varian ESP-12E umumnya digunakan karena sudah 

dilengkapi dengan regulator 3,3 V dan antarmuka USB-Serial, sehingga 

memudahkan pemrograman melalui Arduino IDE atau MicroPython . Prosesor 

dapat berjalan dari frekuensi 80 MHz standar hingga 160 MHz, serta menyediakan 

RAM internal mencapai 112 kB dan flash eksternal hingga 4 MB, memiliki hingga 

17 pin GPIO, yang dapat dikonfigurasikan sebagai digital I/O, PWM, I²C melalui 

bit-bang, SPI, atau ADC satu kanal 10-bit Peripheral interface seperti UART, I²S, 

SDIO, dan SPI mendukung integrasi dengan sensor dan modul lain [15]. 

ESP8266 berfungsi sebagai kontroler dan modul komunikasi. Ia membaca 

sinyal analog dari detektor TA7642 melalui pin ADC, memprosesnya lalu mengirim 

data seperti jumlah deteksi sambaran petir, suhu dan kelembapan ke platform online 

seperti ThingSpeak menggunakan koneksi Wi-Fi. 
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Tabel 2 - 1 Spesifikasi ESP8266 [14] 

Kategori Spesifikasi 

Prosesor Tensilica L106 32-bit RISC 

Frekuensi CPU 80 MHz default (opsional hingga 160 MHz) 

RAM ~112 kB (32 kB iRAM + 80 kB dRAM) 

Flash Memory Umum: 4 MB dapat hingga 16 MB optional 

GPIO Hingga 17 pin (digital, PWM, I²C, SPI, I²S, ADC) 

ADC 10-Bit 

Tegangan input 5V - 12V 

Tegangan Kerja 3.3V (operasi stabil antara 2.2V hingga 3.6V) 

Konsumsi Daya 80 mA aktif, <10 µA sleep 

WiFi 802.11 b/g/n (2.4 GHz), output power +19.5 dBm 

Keamanan 

Komunikasi 

WEP/WPA/WPA2 

Platform 

Pengembangan 

Arduino IDE, Espressif IoT Development Framework 

(IDF), PlatformIO 

 

 

Gambar 2. 7 Pin Out ES8266 

 



20 

 

 

 

2.2.5.2 Arduino IDE 

Arduino IDE (Integrated Development Environment) adalah perangkat lunak 

open-source yang dirancang untuk memprogram mikrokontroler Arduino dan 

kompatibelnya, seperti ESP8266. Dikembangkan dengan bahasa pemrograman 

Java, Arduino IDE menyediakan antarmuka pengguna yang sederhana untuk 

menulis, mengedit, dan mengunggah kode ke papan mikrokontroler. Bahasa 

pemrograman yang digunakan berbasis C/C++, dengan struktur program yang 

terdiri dari dua fungsi utama: setup() untuk inisialisasi dan loop() untuk 

menjalankan kode secara berulang . 

 

 

Gambar 2. 8 Arduino IDE 

 

ESP32 adalah mikrokontroler yang dilengkapi dengan fitur Wi-Fi dan 

Bluetooth, menjadikannya ideal untuk aplikasi Internet of Things (IoT). Untuk 

memprogram ESP32 menggunakan Arduino IDE, pengguna perlu menambahkan 

ESP32 melalui Board Manager. Setelah konfigurasi selesai, pengguna dapat 

menulis kode menggunakan struktur Arduino yang familiar dan mengunggahnya ke 

ESP32 melalui koneksi USB [16]. 

Langkah langkah penggunaan Arduino IDE dapat dijelaskan melalui tahapan-

tahapan berikut : 

1. Mengunduh dan menginstal aplikasi Arduino IDE. Setalah instalasi selesai 

membuka aplikasi Arduino IDE. 

2. Menambahkan Board Arduino Nano atau ESP32. 
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Pengguna menambahkan board, Karena ESP32 tidak termasuk dalam board 

default Arduino IDE, maka perlu menambahkan URL board ESP32 melalui  

Buka menu File > Preferences Tambahkan URL berikut ke kolom Additional 

Board Manager URL : https://raw.githubusercontent.com/espressif/arduino-

esp32/gh-pages/package_esp32_index.json. Setelah itu, buka Tools > Board > 

Board Manager, lalu cari “ESP32” dan klik Install. 

3. Menghubungkan ESP32 ke Komputer 

Sambungkan papan ESP32 ke komputer menggunakan kabel USB. Tunggu 

hingga sistem mengenali perangkat dan driver terpasang otomatis. Pada menu 

Tools > Port, pilih port COM yang sesuai dengan ESP32. 

4. Pemilihan Board dan Port 

Pastikan memilih board yang sesuai,“ESP32 Dev Module” pada Tools > Board, 

dan pastikan port COM sudah sesuai dengan perangkat yang terhubung. 

5. Import Library Tambahan 

Untuk mendukung pemrograman sensor dan komunikasi jaringan, tambahkan 

beberapa pustaka yang dibutuhkan melalui Tools > Manage Libraries, seperti: 

Wire untuk komunikasi I2C, Adafruit BME280 untuk sensor 

suhu/kelembaban/tekanan, WiFi.h untuk konektivitas jaringan, ThingSpeak.h 

untuk integrasi dengan platform ThingSpeak. 

6. Menulis Program  

Penulisan program ini berisi intruksi logika yang akan dijalankan 

mikrokontroler. 

 

https://raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/package_esp32_index.json
https://raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/package_esp32_index.json
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Gambar 2. 9 Tampilan area Sketch pada Arduino IDE 

7. Menyimpan Program 

Setelah proses program selesai tahapan selanjutnnya adalah penyimpanan 

program ke folder computer.  

 

2.2.6 Sensor Tekanan BME280 

  Sensor BME280 adalah modul sensor yang dapat mengukur tiga parameter 

lingkungan dengan konfigurasi suhu, tekanan udara dan kelembaban. Sensor ini 

dikembangkan oleh perusahaan Bosch Sensortec sebagai penyempurnaan dari versi 

sebelumnya, BMP280 yang hanya dapat mengukur suhu dan tekanan udara. 

  BME280 bekerja dengan menggunakan sistem mikroelektromekanis 

(microelectromechanical systems atau MEMS) untuk mendeteksi perubahan fisis 

dari udara di sekitarnya. Ketiga sinyal analog tersebut dikonversi menjadi data 

digital menggunakan ADC (Analog to Digital Converter) internal beresolusi 24-bit. 

Proses pembacaan sensor BME280 dilakukan dalam tiga tahap utama. Pertama, 

mikrokontroler membaca data kalibrasi yang tersimpan dalam EEPROM internal 

sensor. Data kalibrasi ini diperlukan untuk mengkompensasi hasil pembacaan 

mentah. Kedua, sensor melakukan pengambilan data mentah dari ketiga parameter 

yang disebutkan, yaitu suhu (raw_temp), tekanan (raw_press), dan kelembaban 

(raw_hum). Ketiga, mikrokontroler menghitung nilai aktual dari setiap parameter 

berdasarkan algoritma kompensasi yang diberikan dalam datasheet resmi Bosch. 
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Proses ini dilakukan secara berurutan, dimulai dari perhitungan suhu karena 

hasilnya akan digunakan dalam proses kalkulasi tekanan dan kelembaban. 

Nilai akhir yang diperoleh dari sensor ini kemudian berupa data suhu dalam satuan 

derajat Celsius, tekanan udara dalam pascal atau hektopascal, serta kelembaban 

dalam persen relatif (%RH) [17]. 

 

Tabel 2 - 2 Spesifikasi Sensor Tekanan BME280 [17] 

Kategori Spesifikasi 

Rentang Tekanan  300 hingga 1100 hPa 

Rentang Suhu -40°C hingga +85°C 

Rentang Kelembaban 0% – 100% RH 

Akurasi Tekanan ±1 hPa 

Akurasi Suhu ±1 °C 

Akurasi Kelembaban ±3% RH 

Konsumsi Daya < 3.6 µA (mode normal) 

Tegangan Kerja  1,8 hingga 3,6 V 

Antarmuka Komunikasi I²C dan SPI 

Dimensi 3,6 × 3,8 × 0,93 mm 

 

Tabel 2 - 3 Pin Out Sensor Tekanan BME280 

Nama Pin Fungsi Keterangan 

VCC Tegangan Input 
Dihubungkan ke tegangan 3,3 V atau 

5 V 

GND Ground Dihubungkan ke ground sistem 

SCL 
Serial Clock (I2C) / 

SPI Clock 

Jalur clock komunikasi data I2C atau 

SPI 

SDA 
Serial Data (I2C) / 

MOSI 

Jalur data komunikasi I2C atau SPI 

(data masuk) 
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Gambar 2. 10 Sensor Tekanan BME280 

 

2.2.7 LCD  

LCD 16x2 merupakan modul tampilan berbasis teknologi Liquid Crystal 

Display (LCD) dapat digunakan untuk menampilkan karakter alfanumerik 

sebanyak dua baris, dengan masing-masing baris terdiri dari 16 karakter.  

LCD 16x2 pada dasarnya terdiri dari dua bagian utama yaitu bagian Backlight 

(Lampu Latar Belakang) dan bagian Liquid Crystal (Kristal Cair). bekerja dengan 

prinsip dasar mengatur orientasi molekul kristal cair menggunakan medan listrik, 

sehingga mengontrol jumlah cahaya yang diteruskan atau dipantulkan untuk 

membentuk karakter yang terlihat pada layar. Modul ini umumnya menggunakan 

driver berbasis HD44780. LCD 16x2 dapat dioperasikan dalam mode 8-bit atau 4-

bit, di mana data yang dikirim dari mikrokontroler ke LCD dapat berupa kombinasi 

bit yang mengatur tampilan huruf, angka, maupun karakter khusus [18]. 

 

Tabel 2 - 4 Spesifikasi LCD [18] 

Kategori Spesifikasi 

Jenis Layar Liquid Crystal Display 

Jumlah Karakter 16 x 2 

Tegangan Kerja 4,7 – 5,3 V 

Arus Operasi 1 mA 

Driver IC HD44780 

Mode Komunikasi  Paralel 4 bit atau 8 bit  

Temperatur Operasional -20°C hingga +70°C 
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Tabel 2 - 5 Pin Out LCD  

Pin Nama Pin Fungsi Keterangan 

1 VSS Ground (GND) 
Jalur ground, dihubungkan ke ground 

mikrokontroler. 

2 VDD 
Tegangan catu 

daya (+5V) 
Biasanya dihubungkan ke tegangan 5V. 

3 VO Kontras layar Diatur menggunakan potensiometer. 

4 RS Register Select 
Pengatur mode perintah/data: 0 = 

perintah, 1 = data. 

5 RW Read/Write 
Pengatur mode baca/tulis: 0 = tulis, 1 = 

baca. Biasanya di-ground-kan. 

6 E Enable 
Sinyal aktif (high) untuk memulai 

pembacaan atau penulisan data. 

7–14 D0–D7 Jalur data 
Jalur data untuk komunikasi 8-bit (D4–

D7 untuk mode 4-bit). 

15 LED+ (A) 
Anoda backlight 

(+) 

Positif backlight, biasanya 5V (dapat 

juga 3.3V dengan resistor). 

16 LED- (K) 
Katoda backlight 

(-) 

Negatif backlight, dihubungkan ke 

ground. 

 

 

 

Gambar 2. 11 LCD 

 

  Modul I2C (Inter-Integrated Circuit) adalah standar komunikasi serial dua 

arah menggunakan dua saluran yang didesain khusus untuk mengirim maupun 

menerima data.  

  Dalam penelitian ini, LCD 16x2 dikombinasikan dengan modul I2C Inter-

Integrated Circuit, yang berfungsi sebagai konverter antarmuka paralel menjadi 

serial. Penggunaan antarmuka I2C pada LCD bertujuan untuk menghemat jumlah 
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pin input/output (I/O) pada mikrokontroler, dari semula 6–8 pin menjadi hanya 2 

pin, yaitu SDA (Serial Data Line) dan SCL (Serial Clock Line). Modul ekspander 

I2C yang umum digunakan biasanya berbasis IC PCF8574, yang mengatur 

komunikasi antara mikrokontroler dan LCD melalui protokol I2C. 

  Cara kerja modul LCD I2C dimulai dari pengiriman sinyal data digital oleh 

mikrokontroler ke ekspander I2C melalui jalur SDA dan SCL. Ekspander kemudian 

menerjemahkan sinyal tersebut menjadi sinyal paralel yang dikenali oleh LCD 

untuk menampilkan karakter. Sebelum digunakan, LCD harus diinisialisasi dengan 

pengaturan format tampilan, pencahayaan, dan posisi kursor. Modul ini sangat 

sesuai digunakan dalam sistem pemantauan karena mampu menampilkan informasi 

secara langsung di perangkat keras, seperti nilai suhu, tekanan, jumlah sambaran 

petir, atau status konektivitas sistem. 

 

Tabel 2 - 6 Spesifikasi I2C  

Kategori Spesifikasi 

Protokol Komunikasi  I2C 

Jumlah Pin 2 pin (SDA-SCL) 

Tegangan Kerja 3,3 – 5 V 

Chip Kontroler PCF8574 atau PCF8574A (expander I/O) 

Kecepatan  Komunikasi 100 kHz 

Alamat 12C 0x27 atau 0x3F (tergantung modul)  

 

Tabel 2 - 7 Pin Out I2C  

Nama Pin Fungsi Keterangan 

GND Ground (Tanah) 
Dihubungkan ke ground 

mikrokontroler. 

VCC 
Tegangan catu daya 

(+5V/3.3V) 

Dihubungkan ke sumber 

daya, biasanya 5V atau 

3.3V. 

SDA Serial Data 
Jalur data untuk 

komunikasi I2C. 
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Nama Pin Fungsi Keterangan 

SCL Serial Clock 

Jalur clock untuk 

sinkronisasi pengiriman 

data. 

 

 

Gambar 2. 12 I2C 

 

2.2.8 Baterai Li Ion 18650 

Baterai merupakan perangkat penyimpan energi kimia yang dapat 

dikonversikan menjadi energi listrik melalui reaksi elektrokimia. Baterai Lithium-

Ion merupakan salah satu jenis baterai yang masif digunakan. Secara umum, baterai 

terdiri dari satu atau lebih sel elektrokimia yang memiliki tiga komponen utama, 

yaitu anoda (elektroda negatif), katoda (elektroda positif), dan elektrolit sebagai 

medium penghantar ion dan separator [19]. Ketika terjadi proses pelepasan energi 

(discharge), reaksi kimia antara anoda dan katoda menghasilkan aliran elektron 

melalui sirkuit eksternal, yang kemudian dimanfaatkan untuk menyalakan 

perangkat elektronik.  

Baterai Li-Ion 18650 merupakan jenis baterai isi ulang berbasis lithium-ion 

dengan ukuran 18mm x 65mm. Baterai Lithium-Ion (Li-Ion) umumnya digunakan 

dalam konfigurasi seri atau paralel. Pada sistem tenaga surya atau perangkat IoT, 

baterai ini sering dipadukan dengan modul BMS (Battery Management System) 

untuk mengontrol pengisian dan pelepasan daya, sehingga meningkatkan keamanan 

dan umur pakai baterai. 

Prinsip kerja baterai Li-Ion melibatkan adanya pergerakan ion litium melalui 

elektrolit dari anoda ke katoda selama proses pelepasan energi, dan sebaliknya 

selama proses pengisian daya. Saat baterai digunakan, ion litium bergerak dari 

negative anoda biasanya berbahan dasar grafit menuju ke positif katoda, sementara 
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elektron mengalir melalui rangkaian eksternal untuk menyediakan energi listrik 

[19]. 

 

Tabel 2 - 8 Spesifikasi Baterai Li Ion 18650 [19] 

Kategori Spesifikasi 

Tegangan Nominal 3,6 V – 3,7 V per sel 

Tegangan Maksimal 4,2 V per sel 

Kapasitas 2000 mAh 

Siklus Pengisian Ulang 300 – 1000 siklus (tergantung kualitas) 

Suhu Operasional -20°C hingga +60°C 

 

 

Gambar 2. 13 Baterai Li Ion 18650 

 

2.2.9 Modul BMS (Battery Management System) 

  Modul Battery Management System (BMS) merupakan perangkat elektronik 

yang dirancang untuk memantau dan mengatur kinerja baterai, khususnya pada 

baterai isi ulang seperti Lithium-Ion. Bertanggung jawab dalam mengelola proses 

pengisian (charging) dan pengosongan (discharging). Secara prinsip, modul BMS 

bekerja dengan cara memonitor parameter penting baterai secara real-time, seperti 

tegangan, arus, dan suhu.  

  BMS dapat berfungsi untuk memprediksi baterai terpakai, mampu memutus 

dan menyambung baterai dari beban jika terdapat gangguan seperti keadaan penuh 

fully charged dan hamir nol almost fully discharged [20]. Modul ini tersedia dalam 

berbagai tipe, tergantung jumlah sel yang dikendalikan, seperti BMS 1S (satu sel), 
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2S, 3S, hingga 6S atau lebih, yang masing-masing menunjukkan jumlah sel baterai 

yang terhubung secara seri [21].  

  TP5100 merupakan modul pengisi daya (charging module) berdaya tinggi 

yang berbasis chip TP5100, diproduksi oleh Top Power ASIC Corp. Modul ini 

mendukung pengisian daya dua mode: pengisian satu sel (1S) dengan tegangan 

output 4,2 volt dan pengisian dua sel (2S) dengan tegangan output 8,4 volt. Mode 

ini dapat diatur melalui konfigurasi pin mode selection. Modul TP5100 mendukung 

arus pengisian hingga 2 ampere dan dilengkapi dengan sistem pengaturan suhu serta 

proteksi terhadap hubung singkat, tegangan lebih, dan arus berlebih. 

  TP5100 bekerja dengan prinsip pengisian berbasiskan switching regulator 

jenis step-down buck converter yang secara efisien mengubah tegangan input lebih 

tinggi (misalnya dari sumber 12V) menjadi tegangan yang sesuai dengan sel baterai 

lithium-ion atau lithium polymer. Dengan efisiensi tinggi hingga ±90%. 

 

Tabel 2 - 9 Spesifikasi BMS TP5100 [20] 

Spesifik

asi 
Detail 

Tegangan Input 5V – 18VDC 

Tegangan Output 4,2V (1S) dan 8,4 (2S) 

Jumlah Sel Baterai 3S (3 seri) 

Arus Maksimum 2A 

Perlindungan Tegangan Berlebih Ya 

Perlindungan Arus Lebih Ya 

Perlindungan Hubungan Pendek 

(Short 
 

Circuit) 

Ya 

Perlindungan         Pengisian         

dan 
 

Pengosongan 

Ya 

 

Tabel 2 - 10 Pin Out BMS TP5100 

Nama Pin Fungsi 

IN + 
Tegangan masukan positif (biasanya dari 

adaptor DC atau panel surya) 

IN - Ground/negatif dari catu daya eksternal. 

BAT + Keluaran positif ke baterai lithium 
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Nama Pin Fungsi 

BAT - 
Keluaran negatif ke baterai lithium 

(ground baterai) 

SET MODE 

 Pin seleksi mode pengisian: 

- Terhubung ke GND → Mode 1S 

(output 4.2V) 

- Tidak terhubung (open) → Mode 2S 

(output 8.4V) 

LED +/ LED - 
Pin indikator LED untuk status charging 

(beberapa modul menyediakan ini). 

 

  

Gambar 2. 14 BMS TP5100 

 

2.2.10 Modul GPS (Global Positioning System) 

  GPS atau Modul Global Positioning System adalah perangkat elektronik yang 

berfungsi untuk menentukan posisi geografis secara akurat di permukaan bumi 

dengan memanfaatkan sinyal dari satelit GPS. Modul ini bekerja dengan cara 

menerima sinyal dari beberapa satelit yang mengorbit bumi, kemudian menghitung 

koordinat lokasi berdasarkan jarak relatif dari masing-masing satelit tersebut. 

  Fungsi utama dari modul GPS adalah untuk memberikan informasi terkait 

koordinat geografis lintang dan bujur, kecepatan gerak, ketinggian dari permukaan 

laut, serta akurasi waktu berdasarkan standar waktu satelit (UTC). Modul GPS Neo-

6MV2 menangkap sinyal radio dari minimal empat satelit GPS yang mengorbit 

bumi. Berdasarkan waktu tempuh sinyal dari satelit ke modul, sistem menghitung 

posisi pengguna menggunakan metode trilaterasi. Modul ini memiliki antena 

keramik aktif bawaan untuk meningkatkan penerimaan sinyal, serta dilengkapi 

dengan EEPROM untuk menyimpan konfigurasi awal dan baterai RTC (Real-Time 

Clock) [22]. Setiap Komunikasi data antara modul dan mikrokontroler dilakukan 

melalui antarmuka UART (TX dan RX) dengan format standar NMEA (National 
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Marine Electronics Association), yang umumnya berisi informasi seperti latitude, 

longitude, waktu UTC, kecepatan, serta kualitas sinyal GPS. 

  Dalam konteks penelitian ini, modul GPS Neo-6MV2 digunakan untuk 

menyimpan dan menampilkan data lokasi alat. Mikrokontroler ESP8266 membaca 

data dari pin TX modul GPS, kemudian mengurai parse string NMEA untuk 

mengekstrak informasi koordinat lokasi.  

 

Tabel 2 - 11 Spesifikasi GPS Module [22] 

Kategori Spesifikasi 

Tegangan Kerja 3,3 V – 5 V 

Arus Maksimal 10 mA 

Batas Operasi  Gravitasi-4g, ketinggian-50000m, 

kecepatan-500m/s 

Sensitivitas Antena -160dBm 

 

Tabel 2 - 12 Pin Out GPS Module 

Nama Pin Fungsi 

VCC Tegangan Input 

GND Ground 

TX Transmit Data 

RX Receive Data 

PPS Pulse Per Second (opsional) 

 

 

Gambar 2. 15 Modul GPS NEO6MV2 
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2.2.11 Buck Converter IC LM2596 

  Buck converter LM2596 merupakan modul regulator tegangan DC-DC yang 

berfungsi untuk menurunkan atau step-down tegangan input menjadi tegangan 

output yang lebih rendah. Dalam aplikasi elektronik modern, termasuk sistem 

monitoring berbasis ESP8266, penggunaan buck converter menjadi penting untuk 

menyesuaikan sumber tegangan input seperti baterai atau adaptor agar sesuai 

dengan kebutuhan tegangan operasional perangkat. 

  LM2596 didasarkan pada teknik switching regulator. Ketika transistor 

switching internal yang membuka dan menutup dengan cepat frekuensi sekitar 150 

kHz untuk memotong tegangan input, lalu menyaringnya dengan induktor dan 

kapasitor agar menjadi output DC yang halus. Rangkaian ini mengatur rasio siklus 

kerja duty cycle sesuai perbandingan antara tegangan input dan output. 

Potensiometer pada modul adjustable digunakan untuk mengatur tegangan output 

sesuai kebutuhan, misalnya dari 1,23 V hingga 30 V [23].  

  Pada modul LM2596, umumnya tersedia potensiometer untuk mengatur 

tegangan output secara manual, serta dioda Schottky, induktor, dan kapasitor filter 

sebagai bagian dari rangkaian pendukung internal IC. Selain itu, beberapa versi 

modul juga dilengkapi display voltmeter mini yang mempermudah pemantauan 

tegangan input dan output. Dalam sistem pendeteksi petir berbasis ESP8266 yang 

dikembangkan dalam penelitian ini, modul buck converter LM2596 digunakan 

untuk menurunkan tegangan dari sumber daya utama baterai 7,4 V menjadi 5 V atau 

3,3 V, sesuai kebutuhan operasional mikrokontroler dan sensor. 

 

Tabel 2 - 13 Spesifikasi Buck Converter LM2596 [23] 

Spesifik

asi 

Detail 

IC Regulator LM2596 

Tegangan Input 4V - 40V DC 

Tegangan Output 1.25V - 37V DC (dapat disesuaikan) 

Arus Maksimum 
3A (disarankan 2A untuk penggunaan 

stabil) 

Frekuensi Switching 150 kHz 
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Spesifik

asi 

Detail 

 

Perlindungan 
Perlindungan terhadap panas berlebih 

 

dan arus lebih 

 

  

Gambar 2. 16 Buck Converter LM2596 

 

2.2.12 PCB 

  Printed Circuit Board (PCB) merupakan papan sirkuit tercetak yang 

berfungsi sebagai media penghubung antar komponen elektronik dalam suatu 

rangkaian. PCB tersusun dari material isolator seperti fiberglass umumnya FR4 

yang dilapisi jalur tembaga sebagai penghantar listrik. Dirancang untuk dapat 

menggantikan kabel konvensional dan memungkinkan koneksi antar komponen 

elektronik seperti resistor, kapasitor, dioda, dan mikrokontroler dengan cara yang 

lebih rapi. 

  Secara umum, PCB dapat diklasifikasikan berdasarkan jumlah lapisan 

konduktor yang dimilikinya, yaitu: 

1. Single Layer PCB: Hanya memiliki satu lapisan konduktor tembaga pada satu 

sisi substrat. Umumnya digunakan pada rangkaian elektronik sederhana. 

2. Double Layer PCB: Memiliki dua lapisan konduktor pada kedua sisi substrat, 

dengan lubang vias sebagai penghubung antar sisi. 

3. Multilayer PCB: Terdiri atas tiga lapisan atau lebih, digunakan pada 

perangkat elektronik kompleks seperti komputer dan sistem komunikasi. 

Jenis ini menawarkan densitas sirkuit tinggi dalam ukuran yang lebih 

kompak. 

  Spesifikasi teknis lainnya meliputi ketebalan substrat, lebar jalur tembaga, 

ukuran pad, jarak antar jalur, dan material soldermask serta silkscreen. 
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 Gambar 2. 17 PCB  

 

  Pada perancangan ini penggunaan PCB merupakan elemen penting, dimana 

pada pembuatan skematik pendeteksi petir. Dimana pada input rangkaian tersebut 

dimulai dari penerimaan sinyal oleh Receiving Coil. Kemudian sinyal diproses pada 

rangkaian agar dapat diterima oleh mikrokontroler ESP8266 melanjutkan sinyal 

supaya dapat diproses. 

 

2.2.13 Buzzer 

  Buzzer merupakan salah satu komponen aktuator yang digunakan untuk 

menghasilkan suara sebagai bentuk peringatan atau notifikasi dalam suatu sistem 

elektronik. Secara umum, buzzer bekerja dengan cara mengubah energi listrik 

menjadi gelombang suara melalui proses getaran yang dihasilkan oleh komponen 

piezoelektrik atau elektromagnetik di dalam buzzer [24]. 

  Berdasarkan prinsip kerjanya, buzzer terbagi menjadi dua jenis, yaitu buzzer 

aktif dan buzzer pasif. Buzzer aktif dilengkapi dengan osilator internal sehingga 

cukup diberi tegangan untuk menghasilkan suara. Sementara itu, buzzer pasif 

membutuhkan sinyal frekuensi eksternal dari mikrokontroler untuk dapat berfungsi 

[25]. Buzzer 3,5 V umumnya merupakan jenis aktif, karena dirancang agar dapat 

bekerja langsung pada tegangan rendah tanpa memerlukan rangkaian pemicu 

tambahan. 

  Dari segi spesifikasi, buzzer 3,5 V memiliki karakteristik konsumsi daya 

rendah, frekuensi suara standar di kisaran 2 kHz–4 kHz, serta ukuran yang kompak, 
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menjadikannya ideal untuk sistem dengan ruang terbatas. Pemilihan buzzer dengan 

tegangan 3,5 V sangat sesuai untuk digunakan bersama mikrokontroler modern 

yang umumnya bekerja pada tegangan logika 3,3 V hingga 5 V, sehingga 

integrasinya menjadi lebih mudah tanpa memerlukan level shifter atau driver 

tambahan. 

 

Gambar 2. 18 Buzzer 

 

2.2.14 Antena Telescopic 

  Antena merupakan perangkat yang berfungsi untuk menangkap atau 

memancarkan gelombang elektromagnetik ke atau dari udara. Antena teleskopik 

merupakan jenis antena eksternal yang memiliki struktur batang logam yang dapat 

ditarik dan diperpanjang sesuai kebutuhan panjang gelombang. Antena ini 

umumnya terbuat dari material konduktor seperti aluminium atau kuningan berlapis 

nikel, dan dirancang untuk menerima atau memancarkan sinyal elektromagnetik 

pada frekuensi tertentu. Dalam sistem penerimaan sinyal radio, khususnya pada 

rentang frekuensi rendah hingga menengah low to medium frequency. 

  Secara teoritis, panjang fisik antena sangat berpengaruh terhadap frekuensi 

kerja optimalnya. Frekuensi resonansi antena didekati dengan rumus: 

𝐿 =  
𝑐

4𝑓
  

 
(2.4) 

 

  dengan L adalah panjang antena, c adalah kecepatan cahaya (3 × 10⁸ m/s), 

dan f adalah frekuensi kerja dalam Hz. Untuk sistem yang bekerja pada frekuensi 

150 kHz hingga 3 MHz seperti pada IC TA7642, maka panjang antena ideal berkisar 

antara 25 cm hingga 150 cm. Rentang ini sesuai dengan karakteristik antena 

teleskopik yang dapat disesuaikan secara praktis. 
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Gambar 2. 19 Antena 

 

  Dalam sistem deteksi petir yang dikembangkan dalam penelitian ini, antena 

teleskopik digunakan bukan untuk menerima sinyal informasi seperti pada siaran 

radio AM konvensional, melainkan untuk menangkap gangguan elektromagnetik 

impulsif dari lingkungan, seperti yang ditimbulkan oleh sambaran petir. Sambaran 

petir memancarkan gelombang elektromagnetik dalam spektrum frekuensi sangat 

luas (wideband), terutama pada rentang Very Low Frequency (VLF) hingga Low 

Frequency (LF), yang dapat menginduksi tegangan sesaat (transien) pada 

konduktor seperti antena. Tegangan inilah yang dimanfaatkan sebagai indikator 

adanya aktivitas petir di sekitar alat. 

 

2.2.15 Resistor 

  Resistor merupakan salah satu komponen elektronik pasif yang berfungsi 

untuk membatasi arus listrik dalam suatu rangkaian. Hambatan ini berguna untuk 

mengatur besarnya arus yang mengalir dan menurunkan tegangan sesuai kebutuhan 

dalam sistem elektronik. Resistor memiliki satuan ohm (Ω). Komponen ini menjadi 

sangat penting dalam hampir seluruh rangkaian elektronik karena kemampuannya 

untuk membatasi arus dan melindungi komponen lainnya dari kelebihan tegangan 

atau arus. 
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Gambar 2. 20 Resistor 

 

  Resistor bekerja dengan mengubah sebagian energi listrik menjadi panas 

sesuai hukum Ohm V=I×RV = I \times RV=I×R. Ketika arus listrik melewati 

resistor, hambatan material di dalamnya menyebabkan sebagian energi hilang 

sebagai panas, membatasi besar arus yang mengalir. Komponen ini sering dirangkai 

secara seri atau paralel untuk mencapai nilai resistansi tertentu sesuai kebutuhan. 

 Pada perancangan alat, resistor digunakan pada rangkaian pendeteksi petir. R5. 

R2 dan R1 masing-masing 1KΩ berfungsi sebagai pembagi tegangan dan kontrol 

arus. 

 

2.2.16 Kapasitor 

  Kapasitor adalah suatu alat atau komponen yang dapat menyimpan energy 

atau muatan listrik didalam medan listrik, dengan cara mengumpulkan 

ketidakseimbangan internal dari muatan listrik. Dalam rangkaian elektronika 

dilambangkan dengan huruf C dan satua kapasitor disebut Farad (F).  

  Fungsi penggunaan kapasitor dalam suatu rangkaian :  

1. Sebagai kopling antara rangkaian yang satu dengan rangkaian yang lain (pada 

PS) 

2. Sebagai filter dalam rangkaian 

3. Sebagai pembangkit frekuensi dalam rangkaian antenna  

4. Untuk menghemat daya listrik pada lampu neon  

5. Menghilangkan bouncing (loncatan api) bila dipasang pada saklar 
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Gambar 2. 21 Kapasitor 

 

  Pada perancangan alat, kapasitor digunakan pada rangkaian pendeteksi petir. 

Kapasitor yang digunakan 100nF, dan 270pF. Kombinasi daripada receiver coil dan 

kapasitor saat penagkapan gelombang berfungsi membentuk filter input dan 

menyesuaikan sinyal dari antena sebelum masuk ke TA7642. Kombinasi induktor 

(receiver coil) dan kapasitor (C4, C5) ini juga berfungsi sebagai tuned circuit untuk 

menyaring frekuensi tertentu. 

 

2.2.17 Dioda 

  Dioda adalah komponen semikonduktor yang memungkinkan arus listrik 

mengalir hanya dalam satu arah. Terdapat berbagai jenis, seperti dioda penyearah, 

Zener, LED, Schottky, dan photodiode, yang masing-masing memiliki fungsi 

berbeda, mulai dari penyearahan arus AC hingga stabilisasi tegangan dan deteksi 

cahaya. 

  Dioda bekerja dengan prinsip sambungan p-n; ketika diberi bias maju, arus 

mengalir, sedangkan saat bias mundur, arus hampir terhenti. Dalam aplikasi praktis, 

dioda digunakan untuk menyearahkan arus, proteksi lonjakan tegangan, dan 

membatasi tegangan pada titik tertentu. 

 

 

Gambar 2. 22 Dioda 
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  Pada perancangan alat, Dioda digunakan pada rangkaian pendeteksi petir. 

Dioda yang digunakan Dioda 1N4001, Dioda yang ditempatkan pada jalur PWM 

Berfungsi sebagai proteksi sekaligus penyearah satu arah terhadap sinyal pembawa 

yang diinjeksikan. Secara khusus, dioda ini menghalangi kemungkinan arus balik 

dari rangkaian atau output TA7642 agar tidak masuk kembali ke pin PWM 

mikrokontroler.  

 

2.2.18 Inductor 

  Induktor adalah komponen pasif yang menyimpan energi dalam bentuk 

medan magnet aliran arus listrik. Jenis-jenis induktor meliputi choke, toroidal, dan 

induktor multilayer, digunakan pada aplikasi filter, konverter daya, dan 

penyimpanan energi. 

  Induktor bekerja berdasarkan hukum Faraday, dimana perubahan arus melalui 

kumparan menciptakan medan magnet yang menghasilkan tegangan lawan (back 

EMF) untuk menghambat perubahan arus mendadak. Dalam rangkaian switching, 

induktor digunakan sebagai elemen penyimpan energi yang dilepaskan saat siklus 

switching. 

 

 

 

 

Gambar 2. 23 Inductor 
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2.2.19 ThingSpeak 

  ThingSpeak adalah platform Internet of Things (IoT) yang dikembangkan 

oleh MathWorks, Platform ini mampu mengirim, menyimpan dan menampilkan 

data bagi pengguna untuk perancacngan alat dengan berbasis IoT. ThingSpeak 

menyediakan antarmuka pemrograman aplikasi (API) berbasis protokol HTTP, 

yang memungkinkan perangkat mengirim data melalui koneksi internet 

menggunakan metode permintaan GET atau POST. 

  Pada perancangan alat berbasis ThingSpeak berfungsi sebagai penyimpanan 

data hasil pembacaan dari alat yang dirancang seperti suhu, kelembapan dan 

aktivitas petir. Kemudian dapat ditampilkan pada Website monitoring. Website 

monitoring adalah sistem berbasis web yang dimaksudkan untuk memantau dan 

mengelola proses atau perangkat. Sistem ini menawarkan antarmuka visual yang 

menarik untuk menampilkan informasi dalam bentuk data yang mudah dipahami 

seperti grafik atau tabel.  

  Selain sebagai media penyimpanan dan tampilan data, ThingSpeak juga 

memiliki keunggulan lain seperti kemudahan integrasi dengan MATLAB untuk 

analisis data lanjutan, fitur notifikasi melalui Webhook atau layanan pihak ketiga 

seperti IFTTT, serta tampilan antarmuka pengguna yang sederhana dan mudah 

digunakan. Hal ini menjadikan ThingSpeak sebagai pilihan yang sesuai untuk 

kebutuhan sistem monitoring berskala kecil hingga menengah, termasuk dalam 

penelitian akademik seperti tugas akhir. 
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Gambar 2. 24 ThingSpeak Dashboard 

 

  Berikut ini adalah tahapan penggunaan Arduino IDE secara sistematis : 

1. Pembuatan Akun dan Channel di ThingSpeak 

Pengguna dapat mengunjungi https://thingspeak.com, Daftar atau login dengan 

akun MathWorks. Kemudian Buat Channel baru: klik Channels > My Channels 

> New Channel. Isi nama channel, deskripsi, dan aktifkan field sesuai jumlah 

parameter seperti pada gambar 2.22. 

 

Gambar 2. 25  Dashboard Channel ThingSpeak 

2. Mendapatkan API Key 

Setelah channel dibuat, tahap selanjutnya masuk tab API KEYS kemudian 

Salin Write API Key (digunakan oleh ESP8266 untuk mengirim data). 

https://thingspeak.com/
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3. Menulis Program di Arduino IDE 

Pada proses program Arduino IDE gunakan library WiFi.h dan ThingSpeak.h 

dan lakukan inisialisasi koneksi Wi-Fi dan ThingSpeak, kemudian Kirimkan 

data sensor (misalnya nilai dari TA7642 dan BME280) ke channel 

menggunakan API Key yang telah didapat. 

4. Visualisasi Data Sensor 

Tahap visualisasi data pengguna masuk ke channel Anda dan pilih tab Private 

View atau Public View, Tambahkan widget grafik (line chart, gauge, numeric 

display, dll.). Atur field yang ingin ditampilkan dan waktu pembaruan. 

5. Pengujian dan Validasi Data 

Lakukan pengujian alat di lapangan demham Pantau apakah data suhu, 

kelembaban, tekanan udara, dan deteksi petir tampil sesuai. Validasi waktu 

delay, akurasi nilai, dan kontinuitas pengiriman. 

  


